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Stereo-PA-Verstarker mit DSP

Diese Anleitung richtet sich an den Installateur der Beschal-
lungsanlage mit entsprechenden Fachkenntnissen. Bitte lesen
Sie die Anleitung vor dem Betrieb griindlich durch und heben
Sie sie fur ein spateres Nachlesen auf. Auf Seite 2 finden Sie
alle beschriebenen Bedienelemente und Anschlisse.
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Stereo PA Amplifier with DSP

These instructions are intended for installers of the PA system
with the corresponding technical knowledge. Please read
these instructions carefully prior to operating the subwoofer
system and keep them for later use. All operating elements
and connections described can be found on page 2.
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Ubersicht der Anschliisse
und Bedienelemente

Signaleingdnge IN-1/IN-2 (XLR) zum
Anschluss einer Signalquelle mit Line-
Pegel; Parallelausgdnge PARALLEL
OUT zum Weiterfilhren des Signals
z.B. zu einer weiteren Verstérkeran-
lage

Status-LEDs
SIG

—24/-6/0dB Ausgangspegel
CLIP

Eingangssignal

Ubersteuerung;
langsames Blinken bei
stummgeschalteten Ein-
géngen

Taste MENU zum Aufruf des Einstell-
menls und zum Beenden der Eingabe
eines Namens oder Passworts

Taste ESC zum Abbruch einer Ein-
gabe und zum Verlassen des Einstell-
menus oder eines Untermenis

LC-Display
RJ45-Buchse flur den Ethernet-An-

schluss zur Konfigurierung des Signal-
prozessors mithilfe eines Computers

USB-Buchse (Typ B) zur Konfigurie-
rung des Signalprozessors mithilfe
eines Computers

Drehknopf SELECT/ENTER zum Aus-
wahlen und zum Andern von Einstel-
lungen; zur Bestatigung einer Auswahl
oder Anderung den Knopf driicken
Signalausgéange OUT-2/OUT-3 fir mit
dem DSP bearbeitete Signale (XLR,
Line-Pegel)

Netzschalter POWER

Halterung fur die Netzsicherung

Eine geschmolzene Sicherung nur
durch eine gleichen Typs ersetzen.
Powercon®-Netzbuchse zum  An-

schluss an eine Steckdose (230V/
50 Hz) Uber das beiliegende Netzkabel

2 Hinweise fiir den
sicheren Gebrauch
Das Gerat entspricht allen relevanten

Richtlinien der EU und ist deshalb mit C€
gekennzeichnet.

WARNUNG Das Gerat wird mit lebensge-
fahrlicher Netzspannung ver-

A sorgt. Nehmen Sie deshalb
niemals selbst Eingriffe am

Geréat vor und stecken Sie
nichts in die Luftungséffnun-
gen. Es besteht die Gefahr
eines elektrischen Schlages.

® Verwenden Sie das Gerat nur im Innen-
bereich und schitzen Sie es vor Tropf-
und Spritzwasser, hoher Luftfeuchtigkeit
und Hitze (zuldssiger Einsatztemperatur-
bereich 0—40°C).

® Stellen Sie keine mit Flussigkeit gefillten
GefaBe z. B. Trinkglaser, auf das Gerat.

® Die im Geréat entstehende Wéarme muss
durch Luftzirkulation abgegeben werden.
Decken Sie darum die Luftungséffnun-
gen nicht ab.

® Nehmen Sie das Gerat nicht in Betrieb
und ziehen Sie sofort den Netzstecker
aus der Steckdose,

1. wenn sichtbare Schaden am Gerat
oder am Netzkabel vorhanden sind,

2. wenn nach einem Sturz oder Ahnli-
chem der Verdacht auf einen Defekt
besteht,

3. wenn Funktionsstérungen auftreten.

Geben Sie das Gerét in jedem Fall zur

Reparatur in eine Fachwerkstatt.

® Ziehen Sie den Netzstecker nie am Kabel
aus der Steckdose, fassen Sie immer am
Stecker an.

® Wird das Gerat zweckentfremdet, nicht
richtig angeschlossen, falsch bedient oder
nicht fachgerecht repariert, kann keine
Haftung fir daraus resultierende Sach-
oder Personenschaden und keine Garan-
tie fur das Gerat bernommen werden.
Ebenso kann keine Haftung fir durch
Fehlbedienung oder durch einen Defekt
entstandene Datenverluste und deren Fol-
geschaden Gbernommen werden.

Soll das Gerat endgiiltig aus dem
Betrieb genommen werden, Uber-
geben Sie es zur umweltgerechten

mmm Entsorgung einem ortlichen Re-
cyclingbetrieb.

3 Einsatzmoéglichkeiten

Diese aktive Subwoofer-Lautsprecherbox
ist gleichermaBen fir Festinstallationen
sowie den mobilen Einsatz, z.B. auf der
Bihne und in der Diskothek konzipiert. Sie
dient zur tieffrequenten Ergdnzung in einer
bestehenden Verstérkeranlage, wenn be-
sondere Anforderungen an die Tiefbass-
wiedergabe gestellt werden. Der integrierte
Verstérker arbeitet mit zwei Schaltendstu-
fen (Klasse D) und liefert eine Spitzenleis-
tung von 2400W an die beiden 38-cm-
Hochleistungslautsprecher (15”).

Zwei Line-Pegel-Ausgénge stellen Sig-
nale zur Verfligung, die, wie das Subwoo-
fersignal fur die eingebauten Lautsprecher,
mit dem integrierten Signalprozessor
(DSP) bearbeitet werden kénnen. Der Sig-
nalprozessor kann somit als Frequenzwei-
che fur den Subwoofer und die Gbrige PA
eingesetzt werden. Ein Beispiel fir eine
solche Geréatekonstellation ist in der Abbil-
dung 2 gezeigt. Weiterhin stehen mit dem
DSP fir jeden Ein- und Ausgang der Sub-
wooferbox zahlreiche Signalverarbeitungs-
moglichkeiten durch verschiedene Filterar-
ten, Kompressor, Pegelbegrenzung, Pha-
senumkehr und Signalverzégerung zur
Verfugung. Dadurch l&sst sich die Subwoo-
ferbox optimal an die anderen verwende-
ten Lautsprecher und an die akustischen
Eigenschaften am Einsatzort anpassen.
Alle Einstellungen kénnen an der Subwoo-
ferbox oder mit einem per USB oder Ether-
net verbundenen Computer editiert und als
Presets in der Subwooferbox gespeichert
werden. Eine Steuerung durch Tabletcom-
puter ist ebenfalls moglich.

Fur die Kidhlung sorgt ein temperatur-
geregelter Lufter. Umfangreiche Schutz-
schaltungen schitzen den Verstarker und
die Lautsprecher.

4 Aufstellméglichkeiten

Die Subwooferbox auf einen festen Unter-
grund stellen. Sie hat an der schmalen und
an der breiten Seite GummifiiBe, sodass
sie auf zwei Arten aufgestellt werden kann.
Bei der Verwendung eines einzelnen Sub-
woofers ist die genaue Positionierung in
der Mitte zwischen den Stereo-Lautspre-
chern nicht entscheidend. Die von ihm wie-
dergegebenen sehr tiefen Frequenzen las-
sen sich nicht genau orten. Bei der Aufstel-
lung immer darauf achten, dass Luft unge-



hindert durch alle Luftungséffnungen stré-
men kann, damit eine ausreichende Kih-
lung des Verstarkers gewahrleistet ist.

Auf die Subwooferbox kann eine an-
dere Lautsprecherbox montiert werden.
Daflr sind in den nach oben zeigenden
Griffmulden M20-Gewinde vorhanden, an
denen ein Distanzrohr (z.B. KM-21367)
befestigt werden kann.

4.1 Transport

Vor dem Transport alle Anschlisse tren-
nen sowie auf der Subwooferbox montierte
Lautsprecher entfernen. Fir den Transport
die Subwooferbox auf ihre Rollen stellen
und die Abdeckung zum Schutz des Front-
gitters aufsetzen. Zum Festsetzen der Sub-
wooferbox sind zwei der Rollen mit Brem-
sen ausgestattet.

5 Anschluss

Vor dem Anschluss bzw. vor dem Veréan-
dern von Anschliissen die Subwooferbox
und die anzuschlieBenden Gerate aus-
schalten.

1) Die Signalquelle, z. B. Mischpult oder
Vorverstarker, an die XLR-Eingangs-
buchsen IN-1/IN-2 (1) anschlieBen. Die
Eingangssignale sollten Line-Pegel auf-
weisen.

Zum Weiterflhren der Eingangssig-
nale (z. B. zu einer weiteren Verstarker-
anlage) kénnen die parallelgeschalteten
XLR-Buchsen PARALLEL OUT verwen-
det werden.

2) Die Line-Ausgédnge OUT-2/0OUT-3 (9)
kénnen mit dem Line-Pegel-Eingang
eines anderen Gerats (z. B. Verstarker,
Aktivlautsprecher, Aufnahmegerét) ver-
bunden werden. Die Art des Signals ist
von der Konfiguration des Signalprozes-
sors abhéngig. So kann beispielsweise
Uber Hochpassfilter ein Stereosignal fur
den Hoch-/Mitteltonbereich erzeugt wer-
den, dessen Frequenzbereich optimal
an den des Subwoofers anschlieBt.

3) Zum Fernsteuern der Subwooferbox
oder zum Konfigurieren der Presets die
Subwooferbox Uber die RJ45-Buchse
LAN (6) mit einem einzelnen Computer
oder einem Computernetzwerk verbin-
den (s Kap. 7.2).

Alternativ lasst sich ein Computer
auch Uber die USB-Buchse = (7)
anschlieBen.

4) Zur Stromversorgung die Subwoofer-
box Uber die Netzbuchse (12) mit dem
beiliegenden Netzkabel an eine Steck-
dose (230V/50Hz) anschlieBen. Den
blauen Powercon-Stecker des Netz-
kabels nach dem Einstecken in die
Netzbuchse nach rechts drehen, bis er
einrastet. Zum spateren Herausziehen
den Sicherungsriegel am Stecker
zurlickziehen und den Stecker nach
links drehen.

6 Bedienung

VORSICHT: Die Einstellung der Lautstarke
erfolgt digital Gber den Endlosdrehknopf (8)
oder per Fernsteuerung uber ein Netzwerk
oder die USB-Schnittstelle. Daher kann
diese Einstellung vor dem Einschalten des
Gerates weder verandert noch abgelesen
werden. Ist nicht bekannt, mit welcher Ein-
stellung die Subwooferbox einschaltet,
sollten die Signalquellen zunachst ausge-
schaltet bleiben.

Die Subwooferbox mit dem Schalter
POWER (10) einschalten. Das Dlsplay (5)
zeigt  zunéchst I
wobei alle LEDs (2) Ieuchten Anschlle-
Bend in der oberen Zeile den Namen der
Subwooferbox, in der unteren Zeile den
Namen des aktuellen Presets.

VORSICHT Stellen Sie die Lautstarke nie

sehr hoch ein. Hohe Laut-

A starken koénnen auf Dauer

das Gehor schadigen! Das

Ohr gewdhnt sich an sie und

empfindet sie nach einiger

Zeit als nicht mehr so hoch.

Darum eine hohe Lautstarke

nach der Gewdhnung nicht
weiter erhdhen.

6.1 Zugriffsebenen

Fur die Konfiguration des Gerats stehen
vier Zugriffsebenen mit unterschiedlichen
Rechten zur Verfligung. Der Zugang zu
den Ebenen wird Uber unterschiedliche
Passworter erreicht. Die Passworteingabe
erfolgt an der Subwooferbox (Menupunkt

Foocsss Level: PEnLbaer F areid)
oder uber das Steuerprogramm (Menu-
punkt ,Hardware #Enter Password",
15 Kap. 8.7.1).

Die folgende Tabelle zeigt die Zugriffsebe-
nen in absteigender Rangfolge und die
zugehdrigen Passworter.

Zugriffsebene Passwort*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State —

(3 Passwortvorgaben

*Diese Passworter sind vom Werk vorgegeben und
kénnen vom Anwender in der jeweiligen Zugriffs-
ebene oder einer héheren Ebene geédndert wer-
den. — Geanderte Passworter gut merken!

Die Passworter sind in der Subwooferbox
gespeichert. Nach dem Einschalten ist die
Subwooferbox normalerweise in der Ebene
sUser“. Nach der Eingabe eines Passwor-
tes befindet sich die Subwooferbox dann in
der entsprechenden Zugriffsebene, bis sie
ausgeschaltet wird, ein anderes Passwort
eingegeben wird oder in den ,Locked
State” gewechselt wird. Der ,Locked State”
kann an der Subwooferbox uber den
Mendpunkt & = |
oder im Steuerprogramm Uber den Menu-

punkt ,Hardware » Lock Unit“ erreicht wer-
den.

Es kénnen in einer héheren Ebene
jeweils die Bedienmdglichkeiten der niedri-
geren Ebenen eingeschrénkt werden. Dies
ist jedoch nur Uber das Steuerprogramm
maoglich (i Kap. 8.7).

6.2 Betrieb ohne Computer

6.2.1 Preset aufrufen

Hinweis: Die Verfligbarkeit dieser Funktion ist
von den Zugriffsrechten der aktuellen Zugriffs-
ebene abhéangig (1= Kap. 8.7).

1) Die Taste MENU (3) er']cken sodass im

cherplatznummer und darunter der
Name des zuletzt gewdhlten Presets
angezeigt wird.

2) Durch Drehen des Knopfes SELECT/
ENTER (8) das gewlinschte Preset aus-
wahlen und durch Driicken desselben
Knopfes bestatigen. Die folgende Mel-
dung erscheint:

3) Zum Laden des gewdhlten Presets den
Knopf SELECT/ENTER nach rechts
drehen, sodass die Anzeige wechselt
auf:

4) Den Knopf SELECT/ENTER driicken.
Das Preset wird jetzt geladen. Wéhrend
des Ladevorgangs wird hinter dem
Namen des Presets ein # gezeigt.

Bei den beschriebenen Schritten fuhrt das
Dricken der Taste ESC (4) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedrickt wird.

6.2.2 Systeminformationen anzeigen
Zum Anzeigen von Systeminformationen:
1) Die Taste MENU (8) so oft driicken, bIS
im Display (5) der Begrlff
.|.I'| 2 IF Addre
25 angezelgt W|rd

2) Durch Drehen des Knopfes SELECT/
ENTER (8) kénnen weitere Informatio-
nen angezeigt werden.

Bei den beschriebenen Schritten fihrt das
Dricken der Taste ESC (4) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedrickt wird.

6.2.3 Ein- und Ausgangsparameter dndern

Bei ausreichenden Zugriffsrechten der
aktuellen Zugriffsebene und des aktuell
geladenen Presets kénnen alle Parameter
fur die Ein- und Ausgangskanéle (z.B. Ver-
starkung, Filterparameter, Verzdgerungs-
zeiten, Dynamikbegrenzung) in der uber-
sichtlichen Darstellung auf dem Computer
durchgefiihrt werden (1= Kap. 8). Ist daflr
kein Computer zur Hand, lassen sich die

Deutsch
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Einstellungen auch direkt an der Subwoo-
ferbox durchfiihren:

1) Wenn erforderlich, einen vorher aufge-
rufenen Menipunkt mit (mehrmaligem)
Driicken der Taste ESC (4) verlassen,
sodass der Geratename und das aktuell
geladene Preset im Display angezeigt
wird.

2) Den Knopf SELECT/ENTER (8) dri-
cken. Es wird die zuletzt bearbeitete
Ein- oder Ausgang angezeigt, z. B.:

it 3 0+ Gain

=159, ledi

3) Der Pfeil zeigt jeweils auf den Parame-
ter, der durch Drehen des Knopfes
gewdhlt werden kann. In diesem Bei-
spiel kann zwischen den Aus- und Ein-
gangen (Out 1/2/3, In 1/2) gewahlt wer-
den. Gekoppelte Eingénge werden z. B.
als ! Z angezeigt und kdnnen nur
gemeinsam gedndert werden.

4) Die Auswahl durch Driicken des Knop-
fes bestatigen.

5) Durch Drehen des Knopfes den ange-
zeigten Wert andern.

6) Bei einigen Untermenis kann durch
Driicken des Knopfes auf den nachsten
einzustellenden Parameter umgeschal-
tet werden.

7) Um zurlick in eine héhere Menlebene
zu gelangen oder die Einstellungen zu
beenden, die Taste ESC (wiederholt)
dricken. Wird langer als eine Minute
keine Taste gedrickt, bricht der Einstell-
vorgang automatisch ab.

6.2.4 Preset speichern

Hinweis: Die Verfugbarkeit dieser Funktion ist
von den Zugriffsrechten der aktuellen Zugriffs-
ebene abhangig (1= Kap. 8.7).

Die aktuellen Einstellungen lassen sich fol-
gendermaBen speichern:

1) Die Taste MENU (3) driicken, sodass im
Display (5) , dahinter die Spei-
cherplatznummer und darunter der
Name des dort gespeicherten Presets
angezeigt wird. Bei einem freien Spei-
cherplatz wird & - angezeigt.

2) Durch Drehen des Knopfes SELECT/
ENTER (8) den gewtlinschten Speicher-
platz auswéhlen und durch Drilicken
desselben Knopfes bestéatigen. Die fol-
gende Meldung erscheint:

3) Durch Drehen des Knopfes SELECT/
ENTER den ersten Buchstaben flr den
Namen des Presets auswahlen und
durch Driicken desselben Knopfes
bestatigen. Auf die gleiche Art alle wei-
teren Zeichen eingeben, jedoch nach
der Wahl des letzten Zeichens nicht den
Knopf dricken.

4) Nach der Wahl des letzten Zeichens die
Taste MENU drlcken. Das Display zeigt
jetzt:

5) Zur Bestatigung den Knopf SELECT/
ENTER dricken. Das Display zeigt
daraufhin kurz:

Die Speicherplatznummer und der Na-
me des gespeicherten Presets werden
jetzt unter dem Geratenamen angezeigt.

Bei den beschriebenen Schritten fihrt das
Dricken der Taste ESC (4) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedrtickt wird.

7 Fernsteuerung liber
einen Computer

In der Subwooferbox befindet sich ein digi-
taler Signalprozessor (DSP), der zum
einen die Aufteilung der Signale auf die
internen Lautsprecher und die Ausgéange
Ubernimmt und zum anderen vielseitige
Mdoglichkeiten zur Frequenzgangkorrektur,
Laufzeitkorrektur und zur Dynamikbegren-
zung bietet. Vom Werk aus ist der DSP
bereits mit einer Grundeinstellung ,Factory
Preset” konfiguriert. Fur eigene Einstellun-
gen, z.B. zum Erstellen einer Frequenz-
weiche oder zur Anpassung der Beschal-
lungsanlage an die Raumakustik, dient die
mitgelieferte Computer-Software. Uber die
Ethernetschnittstelle LAN (6) kann die Sub-
wooferbox mit einem einzelnen Computer,
einem lokalen Computernetzwerk oder,
z. B. Uber einen Router, mit gréBeren Com-
puternetzwerken (Internet) verbunden wer-
den. Fur die korrekte Einrichtung der Ver-
bindung sind unbedingt Netzwerktechnik-
Kenntnisse erforderlich.

Hinweis: Bei einer direkten Verbindung der Sub-
wooferbox mit einem Computer kann die Verwen-

dung eines Crossover-Kabels oder eines entspre-
chenden Adapters erforderlich sein.

Alternativ lasst sich die Subwooferbox aber
auch, ohne die Einrichtung eines Netzwer-
kes, Uber die USB Schnittstelle ~= (7) mit
einem Computer verbinden.

7.1 Installation der PC-Software

Systemvoraussetzung fur die Installation
des mitgelieferten Steuerprogramms ist ein
Computer mit dem Betriebssystem Win-
dows XP mit Service Pack 2 oder einer
héheren Windows-Version oder Mac OS X
ab Version 10.5.8 und einer Ethernet-
Schnittstelle. Die Bildschirmauflésung soll-
te mindestens 1024 x 768 Bildpunkte betra-
gen. Fur die Installation der PC-Software
das Installationsprogramm ,Setup.exe” oder
LSetup [...] .msi“bzw. [...] Controller. mpkg“
(fir Mac OS X) auf der mitgelieferten CD
starten und den Anweisungen des Installa-
tionsprogramms folgen.

Wird die Subwooferbox Uber die USB-
Schnittstelle mit dem Computer verbun-
den, bei der Installation des USB-Treibers

als Quellverzeichnis die mitgelieferte CD
wéhlen.

Windows ist ein registriertes Warenzeichen der Microsoft Corporation
in den USA und anderen Landern. Mac OS ist ein registriertes Waren-
zeichen von Apple Inc. in den USA und anderen Léandern.

7.2 Einrichten der
Netzwerkverbindung

Vom Werk ist die Subwooferbox auf den
automatischen Bezug der Netzwerkeinstel-
lungen von einem DHCP-Server in einem
bestehenden Netzwerk voreingestellt.
Existiert in dem angeschlossenen Netz-
werk kein DHCP-Server, wird die Subwoo-
ferbox automatisch selbst zum DHCP-Ser-
ver und teilt den anderen Teilnehmern des
Netzwerkes jeweils eine IP-Adresse zu,
wenn diese Teilnehmer auf den automati-
schen Bezug von Netzwerkeinstellungen
eingestellt sind.

Sollen im Netzwerk nur feste IP-Adres-
sen verwendet werden, kann der Subwoo-
ferbox mit dem Steuerprogramm eine be-
stimmte Adresse zugeteilt werden.

Die aktuelle IP-Adresse der Subwoo-
ferbox kann Uiber das Menl angezeigt wer-
den (1 Kap. 6.2.2).

Hinweis: Damit die Subwooferbox tber das Pro-
gramm konfiguriert werden kann, mussen der
Computer und die Subwooferbox demselben Teil-
netz angehéren. Ist dies nicht der Fall, kann es
sinnvoll sein, die Subwooferbox zunéchst Uber
Ethernet allein an einen Computer anzuschlieen,
der seine Netzwerkeinstellungen automatisch von
der Subwooferbox bezieht. Uber die so erstellte
Verbindung ist es anschlieBend méglich, die Netz-
werkeinstellungen der Subwooferbox dem vorge-
sehenen Netzwerk anzupassen.

7.2.1 Hinweis zur Ethernet-Schnittstelle
Die Ethernet-Schnittstelle des Gerats er-
laubt nur eine Ubertragungsrate von max.
10 Megabit/s. Bei Netzwerkgeraten, die nur
100 Megabit/s unterstitzen (z. B. FRITZ!Box
3370), muss deshalb ein 10/100-Switch zwi-
schengeschaltet werden.

7.3 Steuerprogramm
1) Auf dem Computer das Steuerpro-
gramm ,DSP Controller aufrufen.

Es erscheint ein Fenster zur Eingabe
des Passwortes fiir den Start des Pro-
gramms. Die Vorgabe ist ,monacor®.
Das Passwort kann aber spater vom
Anwender geédndert werden (i Kap.
7.3.2).

2) Das Passwort eingeben (ohne Anfiih-
rungszeichen und unter Beachtung der
Schreibweise).

Bei falsch eingegebenem Passwort
erscheint die Meldung ,Invalid pass-
word!“. In diesem Fall die Meldung
bestatigen und das Passwort erneut ein-
geben.

Das Ubersichtsfenster (Abb. 4) wird ange-
zeigt. Darin erscheint eine Liste aller ver-
bundenen Geréte.

In der oberen Zeile ,All Units* wird in
Klammern angegeben, wieviele Gerate
momentan ,online“ sind, d.h. in aktiver
Verbindung mit dem Computer stehen.
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(@) Upersichtsfenster

Darunter gibt es fur jedes Geréat eine Zeile
mit verschiedenen Informationen und
Funktionen in den im Folgenden beschrie-
benen Spalten:

1. Schaltflache ® zum Stummschalten
des Geréts
Wahrend der Stummschaltung ist die
Schaltflache rot. Zum Wiedereinschal-
ten des Tons erneut auf die Schaltflache
klicken. Das Klicken auf die Schaltflache
®) in der Zeile ,All Units® fihrt zur gleich-
zeitigen Stummschaltung aller verbun-
denen Gerate.

2. Schaltflache (® zum Identifizieren eines
Geréts
Nach dem Klicken auf die Schaltfla-
che blinkt diese flr einige Sekunden
und mit ihr alle LEDs am Gerét.

3. Symbol @ fiir den Betriebszustand des
Geréts
Es ist im Betrieb des Gerats grun,
im Bereitschaftsmodus (Standby) rot.
Durch Klicken auf das Symbol lasst sich
das Gerat in den anderen Zustand
umschalten. Bei einer unterbrochenen
Verbindung ist das Symbol grau. Wéh-

DSP Controller

File  Tools  Help

B8:06:74:01:19:3C
B8:06:74:01:23:A5
05:AB:F7:55:DE:DL

169.254.40.54
169.254.138.120
USB port 4

rend beim Einschalten eines Gerats
eine neue Verbindung aufgebaut wird,
erscheint am Ende der Liste voruberge-
hend eine zuséatzliche Zeile ,Startup...”
mit dem Symbol ®.

. Die beiden senkrechten Balken || stellen

eine einfache Pegelanzeige fir den Ein-
gang und den Ausgang eines Gerats dar.

. Anzeige des Geratenamens

Der voreingestellte Name kann zur
Unterscheidung gleicher Gerate hier
oder im Konfigurationsfenster (i Kap.
8.2, H) geéandert werden.

. Anzeige der Hardware-Adresse (MAC-

Adresse) der Netzwerk- oder USB-
Schnittstelle des Gerats

Uber diese Adresse lasst sich ein
Gerat immer eindeutig identifizieren.

. Anzeige der IP-Adresse eines Uber ein

Netzwerk verbundenen Gerats

Bei Geraten, die Uber USB ange-
schlossen sind, steht hier die Nummer
der USB-Schnittstelle. Bei unterbroche-
ner Verbindung steht an dieser Stelle
,Offline“.

Group: My_group (2 units)
MEGA-215DSP
MEGA-215DSP

MEGA-215D5P
IMG DSM-48LAN
MEGA-215DSP

x

x

RO

[ Al Units (3 units online)
®

x

x
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@ Ubersichtsfenster mit Gruppe

B8:96:74:01:19:3C
05:AB:F7:55:DE:DL

B8:96:74:01:19:3C
B8:96:74:01:23:45
05:AB:F7:55:DE:DL

s %
169.254.40.54
USE port 4

Enahled

169.254.40.54
169.254.138.120
USEB port 4

8. Schaltflache ¢ zum Aufruf des Konfigu-
rationsfensters (Abb. 7) fur ein Gerat,
das ,online” ist

In der Zeile ,All Units“ kann Uber die
Schaltflache & die Liste der Geréte aus-
geblendet oder Uber ¢ wieder einge-
blendet werden.

7.3.1 Gerategruppen

Mehrere Geréate kénnen zur gemeinsamen
Steuerung in Gruppen zusammengefasst
werden. Sie kénnen so z.B. gemeinsam
stummgeschaltet werden. Welche Para-
meter der gruppierten Gerate gemeinsam
gesteuert werden, lasst sich in den Einstel-
lungen der Gruppe festlegen. Die Zugeho-
rigkeit eines Gerats zu einer Gruppe kann
jederzeit geéndert werden.

7.3.1.1 Neue Gruppe bilden

1) Zum Anlegen einer neuen Gruppe den
Mendpunkt ,Tools » New Group* aufru-
fen.

2) Im angezeigten Fenster in das Feld
+Enter the name of the new group:“ den
gewlinschten Gruppennamen einge-
ben.

In der Liste wird jetzt eine zusétzliche
Zeile fur die Gruppe gezeigt (Zeile
~@roup: ...“ = Abb. 5).

3) Uber die Schaltfliche @ kann eine
Gruppe eingerichtet oder geandert wer-
den. Es kénnen Geréate zugeflgt oder
entfernt werden und es lassen sich
Gruppenname und Kopplungseigen-
schaften andern.

In der Zeile ,Group: ...“ wird jeweils
die aktuelle Anzahl der Gruppenmitglie-
der angezeigt (... units).

4) Uber die Schaltflache ® am Ende der
Zeile ,Group: ...“ kann direkt unter der
Zeile eine Liste aller Gruppenmitglieder
gezeigt oder Uber ) wieder ausgeblen-
det werden.

7.3.1.2 Gruppe l6schen

Zum Loschen einer Gruppe in der entspre-
chenden Zeile auf die Schaltflache & Kli-
cken (1= Abb. 5). Es erscheint eine Sicher-
heitsabfrage zur Bestatigung des Losch-
vorgangs. Wenn der Gruppe zu diesem
Zeitpunkt Gerate zugeordnet sind, er-
scheint eine zusétzliche Sicherheitsab-
frage.

7.3.2 Programmpasswort dndern
Um das Passwort fur den Start des Pro-
gramms zu andern:

1) Den MenUpunkt ,Tools » Change Soft-
ware Password” aufrufen.

2) Im angezeigten Fenster in das Feld
-Enter Old Password:“ das bisherige
Passwort eingeben (vom Werk vorein-
gestellt ist ,monacor®).
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3) Im nun angezeigten Fenster in das Feld
~Enter New Password:“ das neue Pass-
wort eingeben.

4) Im anschlieBend angezeigten Fenster in
das Feld ,Confirm New Password:“ das
neue Passwort zur Bestatigung noch
einmal eingeben und gut merken!

7.3.3 Demo-Modus

Auch wenn kein Gerat mit dem Computer
verbunden ist, lasst sich zu Demonstrati-
onszwecken ein virtuelles Gerat erzeugen.
Dazu den Menlpunkt ,Tools » Enter Demo
Mode“ aufrufen.

In der Liste erscheinen jetzt verschie-
dene virtuelle Gerate mit der zusatzlichen
Bezeichnung ,DEMO...". Wie bei realen
Geraten kann hier Gber die Schaltflache @
das Konfigurationsfenster aufgerufen wer-
den (s Abb. 7).

Um die virtuellen Gerate wieder aus der
Liste zu entfernen, den MenUpunkt ,Tools
» Leave Demo Mode* aufrufen.

7.3.4 Firmware Update

Fur eine reibungslose Kommunikation zwi-
schen dem Steuerprogramm und einem
Gerat missen beide zueinander passende
Versionen haben. Liegt das Steuerpro-
gramm in einer neueren Version vor, kann
die Firmware (Betriebssystem) der Geréate
Uber das Steuerprogramm aktualisiert wer-
den. Dabei gehen alle in den Geréten
gespeicherten Einstellungen verloren. Sol-
len die Einstellungen erhalten bleiben, mus-
sen sie vor der Aktualisierung auf dem
Computer gesichert werden (1=° Kap. 8.11).
Hinweis: Eine Firmware-Aktualisierung geschieht
auf eigenes Risiko. Nach einem Update kann die

Funktionsweise des Gerates von der Beschrei-
bung in der Bedienungsanleitung abweichen.

VORSICHT: Schalten Sie die Signalquel-
len aus oder reduzieren Sie deren Aus-
gangspegel, damit es nach dem Zurlckset-
zen der Einstellungen nicht zu unerwartet
hoher Lautstérke kommt.

Um die Firmware eines Gerats auf den
neuesten Stand zu bringen, den Menu-
punkt ,Tools ®Enable Update* aufrufen.
Hinter den Geréten in der Liste wird jetzt
das Symbol @ angezeigt. Bei einem
grauen Symbol ist kein Update mdglich
(z. B. weil die Firmware des Geréts bereits
aktuell ist oder weil die Zugriffsrechte flr
das Update nicht ausreichen).

Hinweis: Bei einem Uber die USB-Schnittstelle
verbundenen Gerat ist ein Update nicht mdglich.
Verbinden Sie das Gerat fir das Update tber die
Ethernet-Schnittstelle.

Ist das Symbol orange, kann ein Update
erfolgen:

1) In der Zeile des gewinschten Gerats
auf die Schaltflache @) klicken.

2) Es erscheint ein Hinweis, dass das
Gerat wahrend der mehrschrittigen
Aktualisierung nicht ausgeschaltet oder

die Verbindung getrennt werden darf.
Schlagt die Aktualisierung fehl, muss sie
erneut gestartet werden.

Die Aktualisierung mit [OK] starten
oder mit [Cancel] abbrechen.

3) Nach erfolgter Aktualisierung wird eine
weitere Meldung angezeigt. Diese eben-
falls bestatigen.

Um in der Liste die Update-Symbole wie-
der auszublenden, den Menlpunkt , Tools
» Disable Update* aufrufen.

Hinweis: Bei einem Rucksetzen der Einstellun-
gen auf die Werksvorgaben sind auch die Netz-
werkeinstellungen und die Passworter des Gerats
betroffen, d. h. es kann méglicherweise zunéchst
vom Computer nicht mehr auf das Gerat zugegrif-
fen werden.

Ein Update der Firmware ist ebenfalls ber
das Menu des Konfigurationsfensters még-
lich (Hardware » Firmware Update), wenn
sich das Gerat in der Zugriffsebene ,Deve-
lopment” befindet.

7.3.5 Programm beenden

Zum Beenden des Programms den Men(-
punkt ,File »Quit“ aufrufen oder das Pro-
grammfenster schlieBen.

8 DSP konfigurieren

Achtung!

Der Signalprozessor ist in Verbindung mit
dem Steuerprogramm ein effektives Werk-
zeug, mit dem sehr feine, aber auch gra-
vierende Anderungen der Ubertragungsei-
genschaften der Beschallungsanlage még-
lich sind.

Jede Anderung der Parameter sollte
deshalb mit Bedacht und Sachverstand
vorgenommen werden. Extreme Anderun-
gen der Einstellungen kénnen schlimms-
tenfalls zur Schadigung der Lautsprecher
fahren.

Zur Konfiguration des Signalprozessors in
der Liste bei dem Gerat auf die Schaltfla-
che O klicken (1= Abb. 4, 5).

Das Konfigurationsfenster (Abb. 7) mit
der Hauptansicht (MAIN) wird fur das
gewahlte Gerat angezeigt. Auf der linken
Seite wird als Farbfeld neben LINK E der
Verbindungsstatus des Gerats angezeigt.
Bei grinem Feld besteht eine Datenverbin-
dung. Bei rotem Feld ist die Verbindung
unterbrochen, das Andern einer Einstellung
ist dann nicht méglich. Bei einem Versuch
erscheint eine entsprechende Meldung.

Auf dem Bildschirm geénderte Einstel-
lungen werden bei bestehender Verbin-
dung sofort zum Gerét Ubertragen. Die Ein-
stellungen kénnen auf dem Computer und
in der Subwooferbox (1= Kap. 8.2) als Pre-
set gespeichert werden. Zudem kann fest-
gelegt werden, ob beim Einschalten der
Subwooferbox immer ein bestimmtes Pre-
set geladen werden soll oder der letzte Zu-
stand vor dem Ausschalten (1= Kap. 8.10).

Uber die Schaltflachen der linken Sei-
tenleiste kann auf die anderen Ansichten
(X-OVER, IN 1/2, OUT 1/2/3) umgeschal-
tet werden (Abb. 8 —10), wenn die Zugriffs-
rechte des aktuellen Presets dies zulassen
(= Kap. 8.7.3). Uber die Schaltflache
MAIN gelangt man zurlick zur Hauptan-
sicht.

8.1 Signalweg

In der Abbildung 6 ist der Signalweg durch
die Subwooferbox als Blockdiagramm dar-
gestellt. Von den beiden Eingangen durch-
laufen die Signale nach der Analog-Digital-
Umwandlung den Eingangsverstarker
(GAIN), ein Hochpass- und Tiefpassfilter
(HPF+LPF), die 10-Band-Klangeinstellung
(PEQ), die Signalverzégerung (DELAY),
einen Dynamikkompressor (COMPRES-
SOR) und die Pegelbegrenzung (LIMI-
TER). Fir jeden der drei Ausgangskanéle
kann ein eigenes Mischsignal aus den bei-
den bearbeiteten Eingangssignalen er-
zeugt werden. Dieses hat die gleichen
Bearbeitungsmdglichkeiten wie die Signale
der Eingangskanale mit der zusétzlichen
Maoglichkeit der Phasenumkehr (PHASE
INVERT) und wird dann der Digital-Analog-
Umwandlung zugefihrt. Der Ausgangs-
kanal OUT 1 wird Uber zwei Klasse-D-
Endstufen an die internen Tieftonlautspre-
cher geleitet. Die Ausgangskanale OUT 2
und OUT 3 fihren auf die Line-Pegel-
Ausgéange ,OUT-2“ und ,OUT-3“.

Die Parameter zu den gezeigten BI6-
cken konnen in den Ansichten MAIN,
X-OVER, IN 1/2 und OUT 1/2/3 eingestellt
werden. Fur einige Parameter ist der
Zugriff von mehreren Ansichten mdglich.

Hinweis: Die Einstellmdglichkeiten sind von den
Zugriffsrechten der aktuellen Zugriffsebene ab-
héngig (== Kap. 6.1). Um alle Einstellungen
durchfiihren zu kdénnen, sollte beim ersten Aufruf
des Steuerprogramms in die Zugriffsebene ,De-
velopment” gewechselt werden. Von hier aus kon-
nen dann, entsprechend dem fur die Bedienung
des Gerats geplanten Personenkreis, die Zugriffs-
rechte und Passwérter fur die anderen Zugriffs-
ebenen festgelegt werden (1= Kap. 8.7).
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@ Blockdiagramm

8.2 Ansicht MAIN (Abb. 7)

H Schaltflaichen zum Umschalten der An-
sicht

LOCAL PRESETS
Speichern ,Store” der aktuellen Einstel-
lungen als Presets auf dem Computer
(wie Meniupunkt ,File #»Save) und
Laden ,Load" vom Computer (wie Meni-
punkt ,File » Open®)

MEGA-215DSP (B8:96:74:01:1%:3C) (Administrator)
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H UNIT PRESETS

Speichern ,Store“ der aktuellen Einstel-
lungen als Presets in der Subwooferbox
und Laden ,Load” eines in der Subwoo-
ferbox gespeicherten Presets

Den Speicherplatz im Listenfeld wéhlen
und im oberen Feld einen Namen einge-
ben.

DSPCONTROUIER]

LOCAL PRESETS

Load

MAIN

UNIT PRESETS E

RN TN E T TR A R L E

MEGA-215D5P (B8:96:7: v

UNIT NAME E
MEGA-21505P

Status

g
[y Ty CT Y R PR CLET TR [V |

= B

LINK ®

Details>>

L@
| 7.4 | 7.44 ] [ -20.00 [ -15.04 | -15.04 |
[io]mure— 2 e 2 e ®
mi.  Jr sub ML JR |

Temperature

() Ansicht MAIN

B LINK — Verbindungsstatus
Grln = verbunden
Rot = nicht verbunden
Fir den Wechsel zu einem anderen
Gerat, dieses im Listenfeld wahlen.

H UNIT NAME — Name des Geréts; kann
durch Uberschreiben gedndert werden

B GAIN-Regler zur Lautstéarkeeinstellung
fur die beiden Eingadnge, daneben
Pegel-Anzeigen, darunter Eingabe-/
Anzeigefelder fir den Verstarkungswert

GAIN-Regler zur Lautstérkeeinstellung
fur die drei Ausgénge, daneben Pegel-
Anzeigen, darunter Eingabe-/Anzeige-
felder fur den Verstarkungswert

B LINK-Schalter zur Kopplung der beiden
Eingénge

Bl LINK-Schalter zur Kopplung der Aus-
gange 2und 3

M MUTE-Schalter zum Stummschalten
des jeweiligen Ein- oder Ausgangs

i Eingabefelder zur Benennung der Ein-
und Ausgéange

Deutsch
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8.3 Ansicht IN 1/2 (Abb. 8)

[ Schaltflichen zum Umschalten der An-
sicht

B Kurvendarstellung des Amplituden-Fre-
quenzgangs
Zu jedem der 10 parametrischen Filter
gehdrt ein Bezugspunkt (kleines Qua-
drat mit der Filternummer) und eine Fre-
quenzkurve in einer eigenen Farbe. Der
resultierende Frequenzgang aller akiti-
ven Filter ist als weiBe Kurve dargestellt.

Die Filterparameter kénnen zum Teil
auch grafisch eingestellt werden. Dazu
mit der Maus den jeweiligen Bezugs-
punkt verschieben:

— Anderung der Frequenz durch hori-
zontales Verschieben

— Anderung der Verstarkung durch verti-
kales Verschieben

— Anderung der Filtergiite/Bandbreite
durch horizontales Verschieben mit
der rechten Maustaste

— Ein- oder Ausschalten eines Filters
durch Doppelklick auf den Bezugs-
punkt

Ein-/Ausblenden der Werte aller
aktiven Filter

Q, Feineinstellmodus ein-/ausschalten

% vergréBerte Darstellung = Vollbild-
darstellung; Ruckkehr zur kleinen
Darstellung mit %

1 Kurven als Bilddatei (PNG) spei-
chern

@ GAIN-Regler zur Lautstérkeeinstellung
fur den entsprechenden Eingang, dane-
ben Pegel-Anzeige, darunter Eingabe-/
Anzeigefeld fur den Verstérkungswert
(gleiche Wirkung wie B)

@ Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

8.4 Ansicht OUT 1/2/3 (Abb. 9)

B Schaltflichen zum Umschalten der An-
sicht

Hl Regler MIXER zum Einstellen des
Mischsignals aus den beiden Eingangs-
kanalen fur diesen Ausgang, daneben
Pegel-Anzeigen, darunter Eingabe-/
Anzeigefelder fir den Verstarkungswert

Bl Kurvendarstellung des Amplituden-Fre-
quenzgangs
(Beschreibung 1= Kap. 8.3, [H)

B GAIN-Regler zur Lautstirkeeinstellung
fir den entsprechenden Ausgang,
daneben Pegel-Anzeige, darunter Ein-
gabe-/Anzeigefeld fir den Verstéar-
kungswert (gleiche Wirkung wie H)

B8 Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

MEGA-215DSP (B8:96:74:01:19:3C) (Administrator)
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Ansicht IN 1

M Listenfeld TYPE zur Auswahl des Filter-
typs

Eingabe-/Anzeigefeld FREQ fir die Fil-
terfrequenz (Werte in Hz eingeben)

B Eingabe-/Anzeigefeld Q/BW fiir die Fil-
tergute/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

B Eingabe-/Anzeigefeld GAIN fir die
Pegelanhebung/-absenkung des Filters
Hl Hochpassfilter HPF: Eingabe-/Anzeige-

feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off* < 20 Hz)

Bl Hochpassfilter HPF: Listenfeld fur die
Auswahl des Filtertyps

A Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

8 Tiefpassfilter LPF: Listenfeld fur die
Auswahl des Filtertyps

MEGA-215DSP (B8:96:74:01:19:3C) (Administrator)
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PEQ
ON TYPE
ML E Bellm

Bl MUTE-Schalter zum Stummschalten
des entsprechenden Eingangs (gleiche
Wirkung wie )

B8 Schaltfliche COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fir den
Kompressor des entsprechenden Ein-
gangs (1= Kap. 8.6)

H3 Drehregler DELAY mit Eingabe-/Anzei-
gefeld fur die Einstellung der Signalver-
zbgerung des entsprechenden Ein-
gangs; im Listenfeld darunter die Einheit
wahlen: Zeit oder Entfernung (zur auto-
matischen Berechnung der Schalllauf-
zeit)

Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

H Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld fur die
Ruckstellzeit (release time)

-15
10k 20k

MUTE O

wer @] @
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2.56kHz oty

R

5.12kHz

[ o[ 200a5 | sedss |

10.2kHz| 1
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HPF 53] [59] LPF [70] m

(9) Ansicht OUT 1




B Listenfeld TYPE zur Auswahl des Filter-
typs

EH Eingabe-/Anzeigefeld FREQ fiir die Fil-
terfrequenz (Werte in Hz eingeben)

H Eingabe-/Anzeigefeld Q/BW fiir die Fil-
terglte/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

Eingabe-/Anzeigefeld GAIN fur die
Pegelanhebung/-absenkung des Filters

Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off < 20 Hz)

B Hochpassfilter HPF: Listenfeld fur die
Auswahl des Filtertyps

M Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

Bl Tiefpassfilter LPF: Listenfeld fir die
Auswahl des Filtertyps

B MUTE-Schalter zum Stummschalten
des entsprechenden Ausgangs (gleiche
Wirkung wie M)

Schalter INVERT fiir die Phasenumkehr

M@ Schaltfliche COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fir den
Kompressor des entsprechenden Aus-
gangs (1= Kap. 8.6)

[H Drehregler DELAY mit Eingabe-/Anzei-
gefeld fur die Einstellung der Signalver-
zbgerung des entsprechenden Aus-
gangs; im Listenfeld darunter die Einheit
wéhlen: Zeit oder Entfernung (zur auto-
matischen Berechnung der Schalllauf-
zeit)

M Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld flr die
Ruckstellzeit (release time)

MEGA-215DSP (B8:96:74:01:1%:3C) {(Administrator)

File  Hardware Help

CROSSOVER

8.5 Ansicht X-OVER (Abb. 10)

[ Schaltflachen zum Umschalten der An-
sicht

[ Kurvendarstellung des Amplituden-Fre-
quenzgangs fur alle Hoch- und Tief-
passfilter
Durch die Darstellung aller drei Aus-
gange in einem Diagramm werden bei
der Erstellung einer Frequenzweiche
die Frequenzlbergange deutlich. (Bei
einer Kopplung der Ausgénge 2 und 3
werden nur zwei Filterkurven angezeigt.)

Die Grenzfrequenzen der Filter wer-
den durch dreieckige Marken oberhalb
der Kurve dargestellt. Durch Verschie-
ben einer Marke mit der Maus lasst sich
die Frequenz andern (alternativ zur
numerischen Eingabe in Bl/B).

Bl Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off < 20 Hz)

(gleiche Wirkung wie E)

Hl Hochpassfilter HPF: Listenfeld fir die
Auswahl des Filtertyps (gleiche Wirkung
wie E)

B Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off“ > 20 kHz)

(gleiche Wirkung wie i)

B Tiefpassfilter LPF: Listenfeld fir die
Auswahl des Filtertyps (gleiche Wirkung
wie [l)

B Eingabe-/Anzeigefeld G (gain) fur die
Einstellung der Lautstarke des Aus-
gangs (gleiche Wirkung wie H und )

H Eingabe-/Anzeigefeld D (delay) fir die
Einstellung der Signalverzégerung des
Ausgangs (gleiche Wirkung wie [H)

Pegelanzeigen fir die Ausgénge

Schalter LINK zur Kopplung der Aus-
génge 2 und 3 (gleiche Wirkung wie El)

OUTPUT LEVEL

@ &

MUTE

D OO B

PHASE INVERT

el & [

0.0ms

Ansicht X-OVER

o a6 mn- muET

Bl MUTE-Schalter zum Stummschalten
des jeweiligen Ausgangs (gleiche Wir-
kung wie )

Bl Schalter PHASE INVERT fir die Pha-
senumkehr des jeweiligen Ausgangs
(gleiche Wirkung wie [H)

8.6 Fenster COMPRESSOR
MEGA-215DSP (B8:96:7... (= |[O|[X]

File  Hardwate

COMPRESSOR

Preset  Help

Threshold

Release

Ratio .

Makeup Gain

(11) Kompressorkonfigurationsfenster

[ Schaltflache BACK fiihrt zuriick zur vor-
herigen Ansicht

B Pegelanzeige VU und Verstarkungsmin-
derung GR (gain reduction)

& Drehregler Threshold mit Eingabe-/
Anzeigefeld fir den Schwellwert

@ Drehregler Attack mit Eingabe-/Anzei-
gefeld flr die Ansprechzeit

[ Drehregler Hold mit Eingabe-/Anzeige-
feld fur die Haltezeit

[ Drehregler Release mit Eingabe-/Anzei-
gefeld fur die Ruckstellzeit

[ Drehregler Ratio mit Eingabe-/Anzeige-
feld fiir das Kompressionsverhaltnis

Drehregler Makeup Gain mit Eingabe-/
Anzeigefeld far den Pegelverlustaus-
gleich

Deutsch
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8.7 Zugriffsrechte verwalten

8.7.1 Passworter eingeben

Nach dem Einschalten des Gerats ist nor-
malerweise die Zugriffsebene ,User” ge-
wéhlt (i Kap. 6.1). Um in eine hdhere
Zugriffsebene zu gelangen, das entspre-
chende Passwort Uber den MenUpunkt
.Hardware » Enter Password“ eingeben.

8.7.2 Passworter dandern

Zum Andern des Passwortes der aktuellen
Zugriffsebene oder, in der Ebene ,Develop-
ment, zum Andern der Passworter fir eine
niedrigere Zugriffsebene den Menupunkt
~Hardware » Configure » Change Password"
bzw. ,Hardware » Passwords » User/Admin/
Developer Password” aufrufen.

Fur das Passwort der aktuellen Ebene
ist es erforderlich, zun&chst das bisherige
Passwort einzugeben, dann das neue, wel-
ches dann noch einmal zur Bestétigung
eingegeben werden muss. Passworter fir
niedrigere Zugriffsebenen kénnen dage-
gen direkt eingegeben werden und werden
auch angezeigt.

In der Ebene ,Development® ist es
zudem mdglich, einzelne Presets mit
gesonderten Passwoértern zu versehen.
Vor dem Speichern eines Presets miissen
dafir die gewlinschten Einstellungen tber
das Menl ,Preset »Passwords »Admin
Password“ und ,, ... » Developer Password*
vorgenommen werden.

Wichtig: Mit dem Preset gespeicherte
Passworter haben Vorrang vor den System-
passwortern. Wird ein Preset aufgerufen,
das mit individuellen Passwortern fur die
Zugriffsebenen ,Administrator® und ,Deve-
lopment” gespeichert wurde, sind die Sys-
tempasswaorter fur diese Ebenen unguiltig.

8.7.3 Zugriffsrechte d&ndern

Uber den Meniizweig ,Hardware » Confi-
gure # Access Rights” kdnnen die Zugriffs-
rechte fir die niedrigeren Zugriffsebenen
festgelegt werden. Die Tabelle (Abb. 12)
zeigt die Mdglichkeiten und Voreinstellun-
gen fir die einzelnen Ebenen.

Eine Besonderheit stellt der Zugriff auf
die Einstellungen der Ein- und Ausgangs-
parameter dar. Die Zugriffsrechte hierfr
(Access Input/Output Channel) werden
ausschlieBlich in der Ebene ,Development”
mit dem jeweiligen Preset gespeichert. Vor
dem Speichern eines Presets missen
dafur die gewlinschten Einstellungen tber
das jeweilige Menl ,Preset »Access
Rights # Locked Access Rights®, ,,... # User
Access Rights“ und , ... »Admin Access
Rights“ vorgenommen werden.

8.8 Locked State

Um in die unterste Zugriffsebene ,Locked
State” zu gelangen, den Menupunkt ,Hard-
ware B Lock Unit“ aufrufen. Eine Meldung
wird angezeigt, die darauf hinweist, dass
diese Ebene nur Uber die Eingabe eines
korrekten Passworts einer héheren Ebene
wieder verlassen werden kann. Die Mel-
dung mit OK bestatigen.

8.9 Standby

Um das Gerét in den Bereitschaftsmodus
~otandby” zu versetzen, den MenUpunkt
.Hardware » Go to Standby“ aufrufen. Fir
die Ruckkehr zum normalen Betrieb dann
den Meniipunkt ,Hardware » Exit Standby*
aufrufen (vgl. Kap. 7.3).

8.10 Einschalt-Preset festlegen

Um festzulegen, mit welchen Einstellungen
das Geréat einschalten soll, den MenUpunkt
~Hardware » Configure » Power On Preset”
aufrufen.

Im Listenfeld des angezeigten Fensters
das Preset wéahlen, das jedes Mal nach
dem Einschalten des Geréats automatisch
geladen werden soll oder die Option ,Last
Setting“, damit das Gerat nach dem Ein-
schalten immer die letzten vor dem Aus-
schalten durchgefuhrten Einstellungen be-
halt.

8.11 Sichern/Zuriickladen
aller Presets

Zum Sichern aller Presets des Gerats auf
dem Computer den Menupunkt ,File
» Backup Presets* aufrufen und den Spei-
cherort (Ordner) wahlen.

Zum spateren Zuruckladen der gesi-
cherten Presets den Menupunkt ,File
» Restore Presets” aufrufen.

9 Steuerung liber einen
Tabletcomputer

Zusatzlich zum mitgelieferten Steuerpro-
gramm fir einen PC ist auch ein Steuerpro-
gramm far Tabletcomputer unter der
Bezeichnung ,DSP-CONTROL“ im ,App
Store”“ des Computerherstellers Apple Inc.
erhéltlich.

Zugriffsrechte

Zugriffsebenen

Access Rights

Development Administrator

User Locked State

Load Presets

v o4}

| O

Save Presets

v o4}

] O

Load Factory File

v

Create Factory File

AN

Enable Front Panel Access

Enable Display Lock Control

NN

Change User Access Rights

Change Locked Access Rights

Change Unit Name

AN NN

O

Lock Automatically After Power Cycle

Change Unit Configuration
(Network, AutoStandby, Startup Preset)

Load an Empty Preset

Upgrade the Unit Firmware

Access Input Channel

Access Output Channel

HIR|FO ® OFHRRE

NYANENENERN

OxO0o O OxrM

Oojojoo] o

(12) Mégliche Zugriffsrechte und deren Voreinstellungen

v'= zulassig

M /0 = zulassig / unzuldssig wahlbar



10 Technische Daten

Verstarkerklasse: .. ... ... D
Verstérkerleistung
Sinusleistung: ......... 2000 W
Spitzenleistung: ... .. ... 2400 W
Lautsprecher
Anzahl: .............. 2
GroBe: ............... @ 38cm (15")
Typ: o CELESTION FTR15-4080FD
Frequenzbereich: ...... 28—-300 Hz (typischer Einsatzbereich,
Uber DSP-Konfiguration anpassbar)
Mittlerer Schalldruck: . . . . . 98dB (1 W/1m)

Max. Nennschalldruck: ... 133dB
Nenneingangsspannung: .. 1,2V
Max. Eingangsspannung: . 11V

Eingangsimpedanz: . .. ... 24kQ

Ausgénge OUT2/3: ... ... 3,5 V/1 kQ, symmetrisch
Stromversorgung: ....... 230V/50 Hz
Leistungsaufnahme: .. ... max. 2400 VA
Einsatztemperatur: . .. .. .. 0-40°C
Abmessungen: .......... 1050 x 500 x 650 mm
Gewicht: . .............. 69 kg

Anderungen vorbehalten.

Deutsch

Diese Bedienungsanleitung ist urheberrechtlich fir MONACOR® INTERNATIONAL GmbH & Co. KG geschiitzt.
Eine Reproduktion fiir eigene kommerzielle Zwecke — auch auszugsweise — ist untersagt.
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Connections and
Control Elements

Signal inputs IN-1/IN-2 (XLR) to con-
nect a signal source with line level;
parallel outputs PARALLEL OUT to
route the signal to another amplifier
system, for example

Status LEDs

SIG input signal

—24/-6/0dB output level

CLIP overload;
will flash slowly for muted
inputs

Button MENU to call up the setting
menu and to terminate the entry of a
name or password

Button ESC to cancel an entry and to
exit the setting menu or a submenu

LC display

6 RJ45 jack for the Ethernet connection

10
11

12

to configure the signal processor by
means of a computer

USB jack (type B) to configure the sig-
nal processor by means of a computer
Rotary knob SELECT/ENTER to se-
lect and change settings; to confirm a
selection or setting, press the knob
Signal outputs OUT-2/0OUT-3 for sig-
nals (XLR, line level) processed with
the DSP

POWER switch

Support for the mains fuse
Always replace a blown fuse by one of
the same type.

Powercon® mains jack for connection
to a socket (230 V/50 Hz) via the mains
cable provided

2 Safety Notes

The unit corresponds to all relevant direc-
tives of the EU and is therefore marked
with C€.

WARNING The unit uses dangerous

mains voltage. Leave servi-
A cing to skilled personnel only
and do not insert anything
into the air vents. Inexpert
handling of the unit may

result in electric shock.
® The unit is suitable for indoor use only.
Protect it against dripping water and
splash water, high air humidity and heat
(admissible ambient temperature range:
0-40°C).

® Do not place any vessel filled with liquid
on the unit, e. g. a drinking glass.

® The heat generated inside the unit must
be dissipated by air circulation; never
cover the air vents of the housing.

® Do not operate the unit and immediately
disconnect the mains plug from the
socket

1. if the unit or the mains cable is visibly
damaged,

2. if a defect might have occurred after
the unit was dropped or suffered a
similar accident,

3. if malfunctions occur.

In any case the unit must be repaired by

skilled personnel.

® Never pull the mains cable to disconnect
the mains plug from the socket; always
seize the plug.

® No guarantee claims for the unit and no
liability for any resulting personal dam-
age or material damage will be accepted
if the unit is used for other purposes than
originally intended, if it is not correctly
connected or operated or if it is not
repaired in an expert way. Likewise, no
liability will be accepted for data loss
caused by a defect or operating errors
and for any consequential damage of this
data loss.

B

If the unit is to be put out of opera-
tion definitively, take it to a local
recycling plant for a disposal which
is not harmful to the environment.

3 Applications

This active subwoofer speaker system is
equally designed for fixed installations and
for mobile applications, e. g. on stage or in
discotheques. It is used as a low-frequency
complement to an existing amplification
system with special requirements concern-
ing low-bass reproduction. The integrated
amplifier operates with two power ampli-
fiers (class D) and provides a peak power
of 2400 W at the two 38 cm (15”) high-per-
formance speakers.
Two line level outputs provide signals that,
like the subwoofer signal for the integrated
speakers, can be processed by means of
the integrated signal processor (DSP).
Thus, the signal processor can be used as
crossover network for the subwoofer and
the rest of the PA system. Please refer to
figure 2 for an example of this unit constel-
lation. Additionally, the DSP provides
numerous signal processing options such
as various filter types, compressor, level
limitation, phase inversion and signal delay
for each input and output of the subwoofer
system. Thus, the subwoofer system can
be perfectly matched to the other speakers
used and to the acoustic situation of the
application site. All settings can be edited
at the subwoofer system or with a com-
puter connected via USB or Ethernet and
can be saved as presets in the subwoofer
system. It is also possible to control the
subwoofer system with a tablet computer.
The subwoofer system is equipped with
a temperature-controlled fan to ensure suf-
ficient cooling. Extensive protective circuits
protect both the amplifier and the speakers.

4 Setup Options

Place the subwoofer system on a solid sur-
face. Equipped with rubber feet both on its
short and long sides, the subwoofer system
can be set up in two different ways. When
a single subwoofer is used, it is not impor-
tant to place the subwoofer exactly in the
middle between the stereo speakers as it
will not be possible to precisely locate the
very low frequencies reproduced by the
subwoofer. In order to ensure sufficient
cooling of the subwoofer, air must always
be able to flow freely through the air vents.

It is possible to install another speaker
system onto the subwoofer system: The
handle recesses pointing upwards provide
M20 threads to which a spacer tube (e.g.
KM-21367) can be attached.



4.1 Transport

Prior to transport, disconnect all connec-
tions and remove the speaker systems
installed onto the subwoofer system. For
transport, place the subwoofer system on
its castors and protect the front grille with
the cover. Two castors are equipped with
brakes to keep the subwoofer system in
position.

5 Connecting the
Subwoofer System

Prior to making or changing any connec-
tions, switch off the subwoofer system and
the units to be connected.

1) Connect the signal source, e.g. mixer
or preamplifier, to the XLR input jacks
IN-1/IN-2 (1). The input signals should
have line levels.

The parallel XLR jacks PARALLEL
OUT can be used to route the input sig-
nals (e.g. to another amplification sys-
tem).

2) The line outputs OUT-2/0UT-3 (9) can
be connected to the line level input of a
different unit (e.g. amplifier, active
speaker, recorder). The signal type
depends on the configuration of the sig-
nal processor. It is, for example, possi-
ble to use high pass filters to create a
stereo signal for the high-frequency/
mid-frequency range that perfectly con-
tinues the frequency range of the sub-
woofer.

3) To operate the subwoofer system by
remote control or to configure the pre-
sets, connect the subwoofer system to a
single computer or a computer network
via the RJ45 jack LAN (6) [e= chapter
7.2].

Alternatively, connect a computer via
the USB jack == (7).

4) For power supply, connect the mains
jack (12) of the subwoofer system to a
socket (230V/50Hz), using the mains
cable supplied. Insert the blue Power-
con plug of the mains cable into the
mains jack and turn the plug clockwise
until it engages. To remove the plug, pull
back the latch on the plug and turn the
plug counter-clockwise.

6 Operation

CAUTION: The volume is digitally adjusted
by means of the rotary knob (8) or by
remote control via a network or via the USB
interface; it cannot be changed or read
before the unit is switched on. Therefore,
the signal sources should be switched off
for the time being when the initial adjust-
ment of the subwoofer system at switch-on
is not known.

Switch on the subwoofer system with the
POWER switch (10). Initially, Iritizl-
izind. .. will appear on the display (5),
and all LEDs (2) will light up. Then the
upper line will show the name of the sub-
woofer system and the lower line will show
the name of the current preset.

CAUTION Never adjust the subwoofer
system to a very high volume.

A Permanent high volumes may
damage your hearing! Your ear

will get accustomed to high vol-

umes which do not seem to be

that high after some time.
Therefore, do not further in-

crease a high volume after get-
ting used to it.

6.1 Access levels

Four access levels with different rights are
available for configuring the subwoofer
system. The levels are accessed by differ-
ent passwords. The passwords are entered
at the subwoofer system (menu item
= Lewveli PEnLer P wiread) or
via the control program (menu item “Hard-
ware # Enter Password”, 1 chapter 8.7.1).

Hie

The following table shows the access
levels in descending order and the corre-
sponding passwords.

Access level Password*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State —

@ Factory-set passwords

*These passwords are factory-set; the user can
change these passwords in the respective
access level or in a higher access level. — Make
sure to remember the changed passwords!

The passwords are saved in the subwoofer
system. When the subwoofer system is
switched on, it will usually be in the access
level “User”. When a password is entered,
the subwoofer system will be in the corre-

sponding access level until it is switched
off, a different password is entered or the
access level “Locked State” is called up. To
go to the access level “Locked State”,
either use the menu item * E

i =i at the subwoofer system

or the menu item “Hardware » Lock Unit” of

the control program.

The operating options of a level can be
restricted in a higher level. These restric-
tions, however, can only be made in the
control program (1 chapter 8.7).

6.2 Operation without a computer

6.2.1 Calling up a preset

Note: The availability of this function depends
on the access rights of the current access level
(1= chapter 8.7).

1) Press the button MENU (3) so that
Loazdi will appear on the display (5),
followed by the storage location num-
ber; the name of the preset most
recently selected will appear on the sec-
ond line.

2) Turn the knob SELECT/ENTER (8) to
select the preset desired, then press the
knob to confirm. The following message
will appear:

3) To load the preset selected, turn the
knob SELECT/ENTER clockwise so that
the following message will appear:

i

Lmaed Py o

4) Press the knob SELECT/ENTER. The
preset will be loaded. During the load
process, the name of the preset will be
followed by a .

Pressing the button ESC (4) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.

6.2.2 Showing system information
To show system information:

1) Press the button MENU (3) repeatedly
until i, IF

appears on the dlsplay (5).

2) To show additional information, turn the
knob SELECT/ENTER (8).

Pressing the button ESC (4) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.

English
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6.2.3 Changing input parameters and
output parameters

If allowed by the access rights of the cur-
rent access level and the currently loaded
preset, all parameters for the input chan-
nels and output channels (e.g. gain, filter
parameters, delay times, dynamic range
limitation) can be changed by means of the
well-arranged computer views (s chap-
ter 8). If no computer is available, the
changes can be directly made at the sub-
woofer system:

1) If required, (repeatedly) press the button
ESC (4) to exit a menu item previously
called up so that the name of the sub-
woofer system and the name of the cur-
rently loaded preset are shown on the
display.

2) Press the knob SELECT/ENTER (8).
The input or output most recently edited
will be shown, e.g.:

3) The arrow points to the parameter that
can be selected by turning the knob.
In this example, it is possible to select
between the outputs and inputs
(Out 1/2/3, In 1/2). Linked inputs are
shown as It 1Z, for example, and can
only be jointly changed.

4) Press the knob to confirm the selection.

5) Turn the knob to change the value
shown.

6) In some submenus, the knob can be
pressed to go to the next parameter to
be set.

7) To go back to a higher menu level or to
exit the settings, press the button ESC
(repeatedly). The setting procedure will
also be automatically cancelled after
one minute when no button is pressed.

6.2.4 Saving a preset

Note: The availability of this function depends on
the access rights of the current access level
(1= chapter 8.7).

To save the current settings:

1) Press the button MENU (3) so that
Zavei will appear on the display (5),
followed by the storage location num-
ber; the name of the preset saved at the
storage location will appear on the sec-

2) Turn the knob SELECT/ENTER (8) to
select the storage location desired, then
press the knob to confirm. The following
message will appear:

)

3) Turn the knob SELECT/ENTER to
select the first character for the name of
the preset, then press the knob to con-
firm. Proceed in the same way to enter
the other characters of the name; how-
ever, do not press the knob after select-
ing the final character.

4) After selecting the final character, press
the button MENU. The following mes-
sage will appear on the display:

5) Press the knob SELECT/ENTER to con-
firm. The following message will briefly
appear on the display:

Frs st Ok

The storage location number and the
name of the saved preset will be shown
beneath the unit name.

Pressing the button ESC (4) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.

7 Remote Control via
a Computer

The subwoofer system includes a digital
signal processor (DSP) which on the one
hand splits the signals to the internal speak-
ers and the outputs and on the other hand
offers a wide range of options for equalizing
the frequency response, readjusting the
delay time, and limiting the dynamic range.
The DSP is factory-configured to the basic
setting “Factory Preset”. The computer soft-
ware delivered with the subwoofer system
allows users to define their own settings,
e.g. for creating a crossover network or for
adapting the system to the room acoustics.
By means of the Ethernet interface LAN (6),
the subwoofer system can be connected to
a single computer, a local computer net-
work or, e. g. via a router, to larger computer
networks (Internet). Network technology
expertise is indispensable for the correct
connection setup.

Note: A direct connection of the subwoofer sys-
tem to a computer may require the use of a
crossover cable or a corresponding adapter.

As an alternative (without setting up a net-
work), the subwoofer system can be con-
nected to a computer via the USB interface
== (7).

7.1 Installing the PC software

To install the control program supplied, a
computer with the operating system Win-
dows XP with Service Pack 2 or with a later
Windows version or with Mac OS Xversion
10.5.8 or later and an Ethernet interface is
required. The screen resolution should be
at least 1024 x 768 pixels. To install the PC
software, start the installation program
“Setup.exe” or “Setup [...].msi” or (for Mac
OS X) ‘“[...] Controller.mpkg” on the CD
supplied and then follow the instructions of
the installation program.

If the subwoofer system is connected to
the computer via the USB interface, select
the CD supplied as the source directory
when installing the USB driver.

Windows is a registered trademark of Microsoft Corporation in the
United States and other countries. Mac OS is a registered trademark
of Apple Inc. in the United States and other countries.

7.2 Setting up the
network connection

The subwoofer system is factory-set to
automatically adopt the network settings of
a DHCP server in an existing network. If
there is no DHCP server on the network
connected, the subwoofer system will
assume the function of a DHCP server and
will assign IP addresses to the other net-
work members, provided that they have
been set to automatically adopt network
settings.

If only fixed IP addresses are to be
used on the network, a specific address
can be assigned to the subwoofer system
by means of the control program.

The current IP address of the sub-
woofer system can be shown via the menu
(1= chapter 6.2.2).

Note: The subwoofer system can only be config-
ured by means of the program if the computer and
the subwoofer system belong to the same subnet.
If not, it may be reasonable to first only connect,
via Ethernet, the subwoofer system to a computer
that automatically adopts the network settings
from the subwoofer system. With this connection,
the network settings of the subwoofer system can
then be adapted to the network to be used.

7.2.1 Note concerning the Ethernet interface
The Ethernet interface of the unit only
supports a bit rate of up to 10 megabit/s.
Therefore, a 10/100 switch must be in-
serted for network units that only support
100 megabit/s (e.g. FRITZ!Box 3370).

7.3 Control program
1) At the computer, call up the control pro-
gram “DSP Controller”.

A password-entry window will appear
for starting the program. The factory-set
password is “monacor” which, however,
can later be changed by the user
(r= chapter 7.3.2).

2) Enter the password (without quota-
tion marks and observing the correct
spelling).

If the password is not correctly en-
tered, the message “Invalid password!”
will appear. In this case, confirm the
message and enter the password again.

The overview window (fig. 4) will appear,
displaying a list of all units connected.

In the upper row “All Units”, the text in
parenthesis specifies the number of units
that are currently “online”, i.e. that are
actively connected to the computer. The
rows below the upper row contain the fol-
lowing columns with various information
and functions for the individual units:

1. Button ® to mute the unit
The button will be red when the unit is
muted. To unmute the sound, click the
button again. To mute all units con-
nected at the same time, click the button
® in the row “All Units”.
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@ Overview window

2. Button (® to identify a unit
When this button is clicked, the button
and all LEDs at the unit will flash for a
few seconds.

3. Symbol @ for the operating mode of the
unit
When the unit is in operation, the
symbol will be green; when the unit is in
the standby mode, the symbol will be
red. Click the symbol to change the
mode of the unit. The symbol will be
grey when the connection is interrupted.
When a unit is switched on and a new
connection is being established, an
additional row (“Startup ...”) with the
symbol ® will temporarily appear at the
end of the list.

4. The two vertical bars |l are simple level
indicators for the input and the output of
the unit.

5. Indication of the unit name
For easier distinction of the same
units, the predefined name can be
changed here or in the configuration
window (1= chapter 8.2, H).

DSP Controller

File  Tools  Help

B8:06:74:01:19:3C
B8:06:74:01:23:A5
05:AB:F7:55:DE:DL

169.254.40.54
169.254.138.120
USB port 4

6. Indication of the hardware address
(MAC address) of the network interface
or USB interface of the unit

With this address, a unit can always
be clearly identified.

7. Indication of the IP address of a unit
connected via a network
For units connected via USB, the
number of the USB interface will be indi-
cated. When the connection is inter-
rupted, “Offline” will be shown here.

8. Button & to call up the configuration
window (fig. 7) for a unit that is “online”
To hide the list of units, click the but-
ton ® in the row “All units”. To show the
list again, click the button ().

7.3.1 Unit groups

Multiple units may be grouped so that they
can be jointly controlled (e. g. jointly muted).
The group settings allow the definition of
the parameters that are to be jointly con-
trolled. It is always possible to add units to
the group or remove units from the group.

Group: My_group (2 units)
MEGA-215DSP
MEGA-215DSP

MEGA-215D5P
IMG DSM-48LAN
MEGA-215DSP

x

x

RO

[ Al Units (3 units online)
®

x

x

DSP CONTROLLER

@ Overview window with group

B8:96:74:01:19:3C
05:AB:F7:55:DE:DL

B8:96:74:01:19:3C
B8:96:74:01:23:45
05:AB:F7:55:DE:DL

S X~
169.254.40.54
USE port 4

Enahled

169.254.40.54
169.254.138.120
USEB port 4

7.3.1.1 Creating a new group
1) To create a new group, call up the menu
item “Tools » New Group”.

2) A new window will be displayed. In the
field “Enter the name of the new group:”,
enter the group name desired.

A new row for the group will be added
to the list (row “Group: ...”, 1= fig. 5).

3) To create or change a group, use the
button @. It is possible to add or remove
units, and the group name and the link-
age characteristics can be changed.

The row “Group: ...” indicates the cur-
rent number of group members (... units).

4) Use the button () at the end of the row
“Group ...” to show a list of all group
members directly beneath the row
“Group ...”. To hide the list again, click
the button ®.

7.3.1.2 Deleting a group

To delete a group, click the button @& in the
corresponding row (s fig. 5). A confirma-
tion box will appear, asking you to confirm
the deletion. If units are currently contained
in the group, another confirmation box will
appear.
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7.3.2 Changing the program password
To change the password for starting the
program:

1) Call up the menu item “Tools » Change
Software Password”.

2) A new window will be displayed. In the
field “Enter Old Password:”, enter the
current password (the factory-set pass-
word is “monacor”).

3) A new window will be displayed. In the
field “Enter New Password:”, enter the
new password.

4) A new window will be displayed. In the
field “Confirm New Password:”, enter
the new password again to confirm it.
Make sure to remember the password!

7.3.3 Demo mode

Even when no unit is connected to the com-
puter, it is possible to create a virtual unit
for demonstration purposes. To do so, call
up the menu item “Tools »Enter Demo
Mode”.

Various virtual units with the additional
designation “DEMO...” will be added to the
list. As for real units, the button ¢ can be
used to call up the configuration window
(= fig. 7).

To remove the virtual units from the list,
call up the menu item “Tools » Leave Demo
Mode”.

7.3.4 Firmware update

The control program and the unit must be
equipped with matching firmware versions
to ensure smooth communication. If the
version of the control program is newer, the
firmware (operating system) of the units
may be updated via the control program.
With this update, all settings saved on the
units will be lost. To keep the settings, save
them on the computer (== chapter 8.11)
before starting the update.

Note: Firmware updates are performed at your
own risk. After the update, the functions of the unit
may differ from those described in the instruction
manual.

CAUTION: Switch off the signal sources or
reduce their output level to avoid an unex-
pectedly high volume after the settings
have been reset.

To update the firmware of a unit, call up the
menu item “Tools # Enable Update”. In the
list, the symbol @ will appear after the
units. Units with a grey symbol cannot be
updated (e.g. because the units are
already equipped with the current firmware
version or because the access rights do not
allow for an update).

Note: Units connected via the USB interface can-
not be updated. To update these units, connect
them via the Ethernet interface.

Units with an orange symbol can be up-
dated:

1) Click the button @) in the row of the cor-
responding unit.

2) A message will appear which informs
you that it is not allowed to switch off the

unit or to interrupt the connection during
the multi-step update process. If the
update fails, it must be started again.

Click [OK] to start the update, or click
[Cancel] to cancel it.

3) Upon completion of the update, another
message will appear. Confirm this mes-
sage.

To hide the update symbols in the list
again, call up the menu item “Tools # Dis-
able Update”.

Note: Resetting to the factory settings will also
affect the network settings and the passwords of
the unit, i.e. it may initially not be possible to
access the unit via the computer.

When the unit is in the access level “Devel-
opment”, the firmware may also be up-
dated via the menu of the configuration
window (Hardware » Firmware Update).

7.3.5 Exiting the program

To exit the program, call up the menu item
“File » Quit” or close the program window.

8 Configuring the DSP

Attention!

Combined with the control program, the
signal processor is an effective tool for
making very detailed but also major
changes to the transmission properties of
the PA system.

Therefore, each modification to the
parameters should be performed with
care and expertise. At the worst, extreme
changes to the settings may damage the
speakers.

To configure the signal processor of a unit,
click the button & (1= figs. 4, 5) in the
appropriate row of the list.

The configuration window (fig. 7) with
the view MAIN for the unit selected will
appear. The colour field on the left-hand
side, next to LINK B, will indicate the con-
nection status of the unit. When the colour
field is green, a data connection has been
established. A red field will indicate that the
connection has been interrupted and that it
is not possible to modify settings. If the user
tries to make changes, an error message
will appear.

Any settings changed on the screen will
be instantly transferred to the unit provided
that a data connection exists. The settings
can be saved as presets on the computer
and in the unit (== chapter 8.2). In addition,
it will be possible to define if the subwoofer
system, when being switched on, is to load
a specific preset or the state it was in when
switched off (1= chapter 8.10).

If allowed by the access rights of the
current preset (i chapter 8.7.3.), the
buttons on the left side bar can be used to
go to the other views (X-OVER, IN 1/2,
OUT 1/2/3) [figs. 8—10]. To return to the
main view, click the button MAIN.

8.1 Signal path

Figure 6 shows a block diagram of the path
a signal takes through the subwoofer sys-
tem. Starting at the two inputs, the signals,
after analog/digital conversion, pass the in-
put amplifier (GAIN), a high pass filter
(HPF), a low pass filter (LPF), the 10-band
sound adjustment (PEQ), the signal delay
(DELAY), a dynamic range compressor
(COMPRESSOR) and the level limiter
(LIMITER). For each of the three output
channels, an individual mixed signal can be
created from the two input signals
processed. The mixed signal will have the
same processing options as the signals of
the input channels and additionally the
phase inversion option (PHASE INVERT);
after processing, the mixed signal will be
routed to digital/analog conversion. The
output channel OUT 1 will be routed to the
internal low-frequency speakers via two
class D power amplifiers. The output chan-
nels OUT 2 and OUT 3 will lead to the line
level outputs “OUT-2” and “OUT-3".

The parameters of the blocks shown
can be set in the views MAIN, X-OVER,
IN 1/2 and OUT 1/2/3. Some of the pa-
rameters can be accessed via several
views.

Note: The setting options available depend on the
access rights of the current access level (1= chap-
ter 6.1). To be able to make all settings, go to the
access level “Development” when calling up the
control program for the first time. This level allows
you to define the access rights and passwords for

the other access levels as required by the users
who will operate the unit (1= chapter 8.7).
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@ Block diagram

8.2 View MAIN (fig. 7)
H Buttons to go to a different view

H LOCAL PRESETS
To save (“Store”) the current settings as
presets on the computer (like the menu
item “File ®» Save”) and to load them from
the computer (like the menu item “File
» Open”)

H UNIT PRESETS
To save (“Store”) the current settings as
presets in the subwoofer system and to
load a preset that is saved in the sub-
woofer system
Select the storage location from the list
field and enter a name in the upper field.

MEGA-215DSP (B8:96:74:01:1%:3C) (Administrator)
File  Hardware Help

DSP CONTROLLER

LOCAL PRESETS

Load

MAIN

UNIT PRESETS E
L&R + Sub

12: L&R + Sub

Load

RN TN E T TR A R L E

MEGA-215D5P (B8:96:7: v

UNIT NAME E
MEGA-21505P

Status

g
[y Ty CT Y R PR CLET TR [V |

ot =
LINK @
[ 744 | .44 |
[io]mure— 2 ®
me =

Details>>

Temperature

(@) View MAIN

B LINK — connection status
Green = connected
Red = not connected
To change to a different unit, select the
unit from the list.

H UNIT NAME — name of the unit; over-
write the name to change it

A Controls GAIN to adjust the volume of
the two inputs; the level indicators are
next to the controls; the input/indication
fields for the gain value are beneath the
controls

Controls GAIN to adjust the volume of
the three outputs; the level indicators
are next to the controls; the input/indica-
tion fields for the gain value are beneath
the controls

H Switch LINK to link the two inputs
Bl Switch LINK to link the outputs 2 and 3

@ Switches MUTE to mute the correspon-
ding input or output

K Input fields to name the inputs and out-
puts
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8.3 View IN 1/2 (fig. 8)
B Buttons to go to a different view

B Curve diagram of the magnitude fre-
qguency response
Each of the 10 parametric filters has a
point of reference (small square with fil-
ter number) and a frequency curve in a
specific colour. The frequency response
resulting from all active filters is repre-
sented by a white curve.

Some of the filter parameters can also
be set graphically. To do so, move the
corresponding point of reference with
the mouse:

—move horizontally to change the fre-
quency

— move vertically to change the gain

— move horizontally with the right mouse
button to change the quality factor/
bandwidth

— double-click a point of reference to
switch the corresponding filter on or off

to show/hide the values of all active
filters

G, to switch the fine-adjustment mode
on and off

% to enlarge the display = full-screen
mode; ® to return to the reduced-
size mode

K to save curves as image files (PNG)

@ Control GAIN to adjust the volume of the
corresponding input; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as @)

H Switches ON to activate/deactivate the
corresponding filter

A List field TYPE to select the filter type

8.4 View OUT 1/2/3 (fig. 9)
E Buttons to go to a different view

Hl Controls MIXER to adjust the mixed sig-
nal from the two input channels for this
output; the level indicators are next to
the controls; the input/indication fields
for the gain value are beneath the con-
trols

Bl Curve diagram of the magnitude fre-
quency response
(description 1= chapter 8.3, [H)

B Control GAIN to adjust the volume of the
corresponding output; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as H)

B Switches ON to activate/deactivate the
corresponding filter

MEGA-215DSP (B8:96:74:01:19:3C) (Administrator)

100

GAIN OoN
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640Hz
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1.28kHz
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2.56kHz b

4.76kHz

I v I @ I v

10.2 kHz

(0.0 | 2400dbu | s0abis |

THR REL
ms -

View IN 1

Input/Indication field FREQ for the filter
frequency (enter values in Hz)

[\ Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and band-
width)

B Input/Indication field GAIN for filter boost/
attenuation

El High pass filter HPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off’ < 20 Hz)

Bl High pass filter HPF: list field to select
the filter type

B8 Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off" > 20 kHz)

B Low pass filter LPF: list field to select the
filter type

MEGA-215DSP (B8:96:74:01:19:3C) (Administrator)

File Hardware Help

PEQ
ON TYPE
ML E Bellm

E Switch MUTE to mute the correspond-
ing input (same effect as M)

B Button COMPRESSOR to call up the
configuration window for the compres-
sor of the corresponding input (e chap-
ter 8.6)

H Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding input; select the
measuring unit from the list field: time or
distance (for automatic calculation of the
sound delay time)

Level LIMITER: rotary knob THR with
input/indication field for the threshold
value

i Level LIMITER: rotary knob REL with
input/indication field for the release time

-15
10k 20k

MUTE O

wer @] @

1.28kHz
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LIMITER
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10.2kHz| 1

[ o[ 200a5 | sedss |
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(9 View OUT 1




Bl List field TYPE to select the filter type

B8 Input/Indication field FREQ for the filter
frequency (enter values in Hz)

H3 Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and band-
width)

B Input/Indication field GAIN for filter
boost/attenuation

Bl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz, “Off” < 20 Hz)

B High pass filter HPF: list field to select
the filter type

M Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off” > 20 kHz)

B Low pass filter LPF: list field to select the
filter type

M Switch MUTE to mute the correspond-
ing output (same effect as M)

Switch INVERT for phase inversion

M Button COMPRESSOR to call up the
configuration window for the compres-
sor of the corresponding output
(i chapter 8.6)

[H Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding output; select the
measuring unit from the list field: time or
distance (for automatic calculation of the
sound delay time)

M Level LIMITER: rotary knob THR with
input/indication field for the threshold
value

Level LIMITER: rotary knob REL with
input/indication field for the release time

MEGA-215DSP (B8:96:74:01:1%:3C) {(Administrator)

File  Hardware Help

CROSSOVER

8.5 View X-OVER (fig. 10)
[H Buttons to go to a different view

[ Curve diagram of the magnitude fre-
quency response for all high pass filters
and all low pass filters
When a crossover network is created, all
three outputs are represented in a dia-
gram so that the frequency crossovers
are easy to identify. (When the outputs 2
and 3 are linked, only two filter curves
are shown.)

The cut-off frequencies of the filters
are represented by triangular markings
above the curve. To change the fre-
quency, move the corresponding mark-
ing with the mouse (as an alternative to
the numeric input in B1/E).

Bl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz; “Off’ < 20 Hz)

(same effect as )

Bl High pass filter HPF: list field to select
the filter type (same effect as Hl)

B Low pass filter LPF: input/indication field
for the cut-off frequency (enter values
in Hz, “Off” > 20 kHz) [same effect as [J]

B Low pass filter LPF: list field to select the
filter type (same effect as M)

Bl Input/Indication field G (gain) for adjust-
ing the volume of the output (same effect
as H and B)

B Input/indication field D (delay) for ad-
justing the signal delay of the output
(same effect as [H)

Hl Level indicators for the outputs

Switch LINK to link the outputs 2 and 3
(same effect as )

OUTPUT LEVEL

@ &

MUTE

D OO B

PHASE INVERT

el & [

0.0ms

View X-OVER

o a6 mn- muET

B Switches MUTE to mute the correspond-
ing output (same effect as M)

Bl Switches PHASE INVERT for phase
inversion of the corresponding output
(same effect as [H)

8.6 Window COMPRESSOR

B=1ES

MEGA-215DSP (B8:96:7...

Eile Hardware Preset  Help

COMPRESS0R

Threshold .

Attack

ooms

-
Makeup Gain

@ Compressor configuration window

[ Button BACK to return to the previous
view
@ Level indicator VU and gain reduction GR

& Rotary knob “Threshold” with input/indi-
cation field for the threshold value

@ Rotary knob “Attack” with input/indica-
tion field for the attack time

& Rotary knob “Hold” with input/indication
field for the hold time

[ Rotary knob “Release” with input/indica-
tion field for the release time

[ Rotary knob “Ratio” with input/indication
field for the compression ratio

Rotary knob “Makeup Gain” with input/
indication field for level loss compensa-
tion
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8.7 Managing access rights

8.7.1 Entering passwords

When the unit is switched on, the access
level “User” will usually be selected
(,=r chapter 6.1). To go to a higher access
level, call up the menu item “Hardware
» Enter Password” and enter the password.

8.7.2 Changing passwords

To change the password in the current
access level, or, in the level “Develop-
ment”, to change the passwords for a lower
access level, call up the menu item “Hard-
ware BConfigure BChange Password”
or “Hardware »Passwords »User/Admin/
Developer Password”.

To change the password of the current
level, first enter the current password, then
enter the new password, and finally re-
enter the new password to confirm it. Pass-
words for lower access levels can be
directly entered and will also be displayed.

In the level “Development”, individual
presets can be saved with separate pass-
words. Prior to saving a preset, make
the desired settings via the menus “Pre-
set # Passwords » Admin Password” and
“... #Developer Password”.

Important: Passwords saved with the pre-
set will take precedence over system pass-
words. When a preset is called up which
has been saved with individual passwords
for the access levels “Administrator” and
“Development”, the system passwords for
these levels will be invalid.

8.7.3 Changing access rights

Via the menu branch “Hardware » Config-
ure # Access Rights”, the access rights for
lower access levels can be defined. The
table (fig. 12) shows the options and fac-
tory-set values for the individual levels.

Particular rules apply concerning the
access to the settings of the input parame-
ters and output parameters. The access
rights for these settings (Access Input/Out-
put Channel) are exclusively saved on the
level “Development” (together with the cor-
responding preset). Prior to saving a pre-
set, make the settings desired via the cor-
responding menu “Preset # Access Rights
»Locked Access Rights”, “... #User
Access Rights” and “... # Admin Access
Rights”.

8.8 Locked State

Call up the menu item “Hardware »Lock
Unit” to go to the lowest access level
“Locked State”. A message will appear to
inform you that you can exit this level
only by entering the valid password of a
higher level. Click “OK” to confirm this mes-
sage.

8.9 Standby

Call up the menu item “Hardware » Go to
Standby” to set the unit to the standby
mode. To return to the normal mode, call up
the menu item “Hardware #»Exit Standby”
(see chapter 7.3).

8.10 Defining the switch-on preset

Call up the menu item “Hardware » Config-
ure #Power On Preset” to define the set-
tings that shall apply when the unit is
switched on.

In the list field of the window displayed,
select the preset that is to be automatically
loaded each time the unit is switched on, or
select the option “Last Setting” if the unit is
to use the settings most recently made
before the unit was switched off.

8.11 Saving/Restoring all presets
Call up the menu item “File ® Backup Pre-
sets” to save all presets of the unit on the
computer, then select the storage location
(folder).

To restore the saved presets, call up
the menu item “File # Restore Presets”.

9 Control viaa

Tablet Computer
In addition to the supplied control program
for PCs, a control program named “DSP-
CONTROL” for tablet computers is avail-
able in the “App Store” of Apple Inc.

Access Rights

Access Levels

Development Administrator

User Locked State

Load Presets

v o4}

| O

Save Presets

v o4}

] O

Load Factory File

v

Create Factory File

AN

Enable Front Panel Access

Enable Display Lock Control

NN

Change User Access Rights

Change Locked Access Rights

Change Unit Name

AN NN

O

Lock Automatically After Power Cycle

Change Unit Configuration
(Network, AutoStandby, Startup Preset)

Load an Empty Preset

Upgrade the Unit Firmware

Access Input Channel

Access Output Channel

HIR|FO ® OFHRRE

NYANENENERN

OxO0o O OxrM

Oojojoo] o

(12) Available access rights and their factory-set values

v'= allowed

M /0O = allowed/not allowed, yet selectable



10 Specifications

Amplifierclass: . ......... D
Amplifier power
RMS power: . .......... 2000 W
Peak power: .......... 2400 W
Speakers
Number: . ............. 2
Size: ... @ 38cm (15”)
Type: ... CELESTION FTR15-4080FD
Frequency range: ...... 28—-300 Hz (typical application range;
can be modified via DSP configuration)
SPL: .. 98dB (1 W/1m)
Max. SPL: ............. 133dB
Rated input voltage: . . . . .. 1.2V
Max. input voltage: . . ... .. 11V
Input impedance: ........ 24kQ
Outputs OUT 2/3: . . ... ... 3.5V/1kQ, balanced
Power supply: .......... 230V/50 Hz
Power consumption: ... .. 2400 VA max.
Ambient temperature: ....0-40°C
Dimensions: ............ 1050 x 500 x 650 mm
Weight: . ............... 69 kg

Subject to technical modification.

All rights reserved by MONACOR® INTERNATIONAL GmbH & Co. KG. No part of this instruction manual may be

reproduced in any form or by any means for any commercial use.
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